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CHAPTER 1   TYPES OF UCM

The Universal Communications Modules (UCM) allows Comfort to
connect via a serial Rs232 interface or Local Area network to a  
computer or external  equipment. The types of UCM include;
1. UCM/05 with Infrared Learner and RS232 Interface
2. UCM/Ethernet for connection to Local Area Network
3. UCM/Audio with Speaker and Microphone connectors
These UCMs all use the same firmware.
This manual describes the Flash-based UCMs which allow
firmware to be upgraded by firmware download
There are also Application-specific UCMs which interface to specific
third party systems for example, UCM/CBUS for Clipsal’s CBUS,
UCM/EIB for the European Installation Bus (EIB) or Instabus.
UCM/Ulti for Ulti lighting swtches, UCM/Smartfit for Honeywell
Smartfit Temperture control system, UCM/GSM for GSM Interface,
CWM for the Comfort Webserver. These UCMs are descrbed in their
individual manuals. All user and installation manuals are available
from the Cytech website http://www.cytech.biz

UCM05
The UCM05 (replacing the UCM/IR)  has the following functions
1. It allows programs on the onboard Nonvolatile Memory (NVM)

ICs (“Master”, “Copy”)  to be transferred to or from Comfort.
This is a useful tool when programming, testing or
troubleshooting  Comfort installations.

2. Comfort’s programming software Comfigurator requires the
UCM to upload and download the configuration file to Comfort. 

3. It allows a PC or other controller to communicate with Comfort
using an RS232 interface, allowing third party products or
software (eg Wizcomfort) to work with Comfort . The RS232
command protocol can be downloaded from www.cytech.biz for
the purpose of development of third party interfaces or
software.

4. It also allows Infrared signals to be learned and saved as .ifr
files which can be assigned to Comfort IR codes via  
Comfigurator. 

5. Comfort Voice/Vocabulary (new version of language) can be
programmed (downloaded) into Comfort using Comfigurator.

6. Allows other Flash-based Comfort and UCM firmware to be
upgraded using Comfigurator Firmware download 

UCM/Ethernet
The UCM/Ethernet is similar to the UCM05 except that instead of an
RS232 interfface, it is  connected to an Ethernet Local Area Network
(LAN) using the TCP/IP protocol. The  IR Learning and Audio
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function are NOT supported by the UCM/Ethernet  Comfigurator and
Wizcomfort will work with the UCM/Ethernet.
Uploading and downloading with UCM/Ethernet will be slower than
for UCM05 (Rs232)

UCM/Audio
The UCM/Audio is idenitical to the UCM05, except that  it also
provides audio (Speaker and Microphone) connections to connect an
external powered speaker and microphone, or to connect to the Line
In or Line Out audio connections on a personal computer. This
allows software like WizComfort to act as a virtual keypad.
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CHAPTER 2   UCM SETUP
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Figure 1.1 - UCM05 Printed Circuit Board

Physical
PCB size: 108 x 88 mm
Mounting Holes: 103 x 83 mm (M3 holes 5 mm from
corners)

Connectors
JP1, - Unused
JP2, JP2A - 4 way headers (12V/Com/KA/KB)
P1 - 9 way D RS232 connector 
JP3 - 12V/COM
JP4 - KA/KB
PP1 and PP3 - for Firmware programming 

Jumper Settings
J2 (RS232/RS485) - insert shunt in “232” position to
enable   the 9 way RS232 connector P1.  For
UCM/Ethernet, J2 should be in the “485” position. For
UCM05 shipped before August 2007, J2 is not soldered,
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and ETH01 cannot be plugged in. Solder a 3 pin header at
J2 and remove R57 (See picture below)
SW7 (RS485 ID) - set according to id of the UCM (see UCM ID
settings below). Do not insert shunts  D to H if present as
these will short the push buttons SW2 to SW6
SW8 - Pin “H” is shunted for Hardware Flow control using
RTS/CTS. The shunt is removed to disable Hardware Flow
control. In normal operation, this shunt should be removed to
disable hardware flow control.
SW8 - Pin “G” should be removed for normal operation. If
SW8-G is inserted, Action 197 to send text to the RS232 port
will not have the STX character before the message and CR to
end the message.  In this case, Action 197  will also disable
reporting of events on RS232 port. A login will reset to the
original condition where STX and CR are added to the message
to allow upload and download to be used. This applies from UCM
5.45. This is used for special applications only.
SW8 - pins “E” and “G” if both are shunted during RESET,
communications is disabled. For testing purposes only
J4 - selects U2 or U3 NVM (Nonvolatile memory) as “Master” for
Copying and Upload/download operations. (older UCM PCB
revisions (A,B,C) had fixed positions for “Master” and “Copy”.

Rework UCM05 PCBs without J2 so that ETH01 can be plugged in to
UCM05
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The picture shows a UCM05 before August 2007 which does not
have the J2 header soldered to the UCM05. In order to add the
ETH01 to the UCM05 to convert to UCM/Ethernet, a 3 pin 2.54 mm
header needs to be soldered at the J2 location. The R57 surface
mount resistor needs to be removed. This allows a shunt to be
plugged in at the “232” position for Rs232 interface or “485”
position for Ethernet interface. This should be attempted by a
person with soldering experience.

Buttons
SW1 - RESET
SW2 - UPLOAD
SW3 - DOWNLOAD
SW4 - TEST
SW5 - COPY
SW6 - COMPARE

LED Indicators

RS232 Transmit to PCD12 (R)
RS232 Receive from PCD11 (G)
RS485 Receive from ComfortD10 (G)
RS485 Transmit to ComfortD9 (R)
Error/ Compare FailureERRD4 (R)
Test/CompareBUSY2D3 (R)
Busy/In OperationBUSY1D2 (R)
UCM ReadyRDYD1 (G)
FunctionLabelLED

ICs
U1 - Microcontroller IC with Firmware marked “UCM 5.125” and
above
U2 -  NVM (Nonvolatile Memory)  - Master or Copy depending
on J4
U3 -  NVM (Nonvolatile Memory) - Master or Copy depending on
J4
U4 - Not used
U5 - RS485 transceiver
U6 - RS232 transceiver
U8, U9 are Infrared LED receivers for learning IR signals. 

UCM ID Settings
Comfort is able to support up to 8 UCMs. SW7 is a set of 3 headers
which determines the UCM id, according to the table below.

ShortShortShort1
SW7 - CSW7 -  BSW7- AID - SW7
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OpenOpenOpen8
OpenOpenShort7
OpenShortOpen6
OpenShortShort5
ShortOpenOpen4
ShortOpenShort3
ShortShortOpen2
SW7 - CSW7 -  BSW7- AID - SW7

Table 1.1 - RS485 ID Settings (SW7)

Do not insert shunts  D to H in SW7 if present as these will
short the push buttons SW2 to SW6

No  Flow ControlFlow Control CTS/RTSH

Send STX/ETX for Action
197

Don't send STX/ETX for
Action 197

G
No EthernetUCM/EthernetF
Not UsedNot UsedA to F
Off - OpenOn -ShortSW8

Table 1-2 - SW8 Settings

SW8 - H shunt when inserted will enable hardware flow control for
RS232 communications. If the shunt is off (default), flow control is
disabled. This can normally be left off (no hardware flow control). In
Comfigurator, Flow control can also be correspondingly disabled in
Options > Connection > Serial Port > Flow Control = None.
SW8-G shunt when inserted will suppress the STX header 03
character and Carriage Return 13 character after the data sent in
Action 197. This is not used normally, except for special interface
applications. If SW8-G is off (default), the STX header is sent before
the characters and Carriage Return (13) is sent after the characters
for Action 197.
SW8-F shunt should  be inserted for UCM/Ethernet. It can be left
out if the UCM is not an Ethernet Module.

Getting Started

Set UCM ID
SW7 (RS485 ID) should normally be set to 1 according to table 1.1
(Shunts A,B,C inserted) if this UCM is used for download/upload. By
convention, UCM ID=1 is reserved for upload/download using
Comfigurator, because when this UCM ID is disconnected, Comfort
does not report “Communications Failure”, while with UCM Ids 2 to
8, Communications failure  will be reported (From O4.141). 
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Other UCMs or types of UCM  may be connected for interfacing to
Honeywell Smartfit, C-Bus or EIB (European Interface Bus). These
other UCMs should be set to higher-numbered Ids, up to 8. UCM Ids
should be sequential, i.e. there should not be any missing ID
numbers, i.e. 1,2,3,4,. and not 1,3,5,7,.
If the ID is changed while power is on,  RESET the UCM by pressing
the RESET switch SW1 on the UCM.
Make sure that no other UCM is set as ID=1 in the system,
otherwise there will be a conflict which will prevent proper
communication.

Number of UCMs
The Number of UCMs in Comfigurator > Modules and Settings is set
to 1 by default. If there are more than 1 UCM in the system, enter
the number of UCMs. This can also be done in Locations Menu on
the keypad (Engineer Menu 7,4,1)
Always RESET the system after changing the number of UCMs

Connections
Connect the UCM to Comfort using the supplied cable with 4-way
IDT connector on both ends.  It plugs into JP2 or JP2A on the UCM
and J15 on Comfort. This supplied cable can be used for short runs
(about 1 meter). If the UCM is located further from the Comfort
panel, up to 100 meters, use a cable with 3 twisted pairs. 12V/GND,
KA/KB are to be paired with one pair as spare. Shielding is not
necessary. The UCM may  also be connected  from the SEM
modules. Ensure that  polarity is correct as this is a common cause
of problems with communications. 
It is not necessary to switch off power to Comfort before plugging in
the UCM connections. The UCM is often connected in order to
download  a configuration using Comfigurator. 
The UCM is connected to the PC serial port via a serial cable with a
9 way male D connector on one end and a 9 way female D
connector on the other end (supplied). The best position for the
UCM is near or next to the PC. This is because RS485 is a balanced
line and is able to be run much longer distances without signal
corruption than the RS232 signal cable. Locate an unused serial
port on the PC and plug in the end with the female D connector.
Older PCs may have 25 way connectors for the serial port in which
case a 9 way male to 25 way female adapter (available from
computer shops) is needed.
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What to Watch Out For
Once the UCM is connected with the ID setting set correctly, the
LEDs D10 (Green) and D9 (red) will flash continuously, and the RDY
green LED should stay on. The RDY LED indicates that the UCM
firmware is running.  D10 indicates RS485 data is being received
from Comfort, and D9 indicates the UCM is replying with RS485  
data to Comfort. The BUSY1, BUSY2, and ERROR LEDs should be
off. If the LED states are not as described, see the Troubleshooting
section for an explanation of the behavior of the status LED
indicators. 

OffD12 (R)
OffD11 (G)
Blinking  z z z z z z z z z zD9 (R)
Blinking FastzzzzzzzzzzzzzzzzzzzzzD10 (G)
OFFBUSY2 (R)
OFFBUSY1 (R)
Steady ONRDY (G)
RemarksBehavior when idleLEDs

If the RDY LED is not on, press the RESET button on the UCM. This
may happen when connecting the UCM 4 way cable to Comfort
without turning off power.  RESET on the UCM usually starts the
UCM operating correctly.

Download and Upload from the PC
When downloading a configuration from Comfigurator to Comfort  or
sending commands from PC software (e.g. WizComfort), you will
see the Green Red LED D11 and Red LED D12 blink quickly. 

Engineer Code for Comfigurator Download 
When downloading or uploading to Comfort using Comfigurator
2.2.0, the Engineer Code is required. This is any valid user code on
Comfort. Engineer code is only valid  after  pressing F0 on the
keypad. This is for protection of the user against unauthorised
access with Engineer code.
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CHAPTER 3  OPERATION

The UCM and NVM (Nonvolatile Memory)

256K (24C256)34Ultra II
64K (24C64)31OPTimum II
256K (24C256)24ULTRA I
64K (24C64)18PRO I
32K (24C32)17ENTRY I
NVM capacity (KBits)File SystemComfort Model

Table 3.1 - NVM Types

The above table shows the types of NVMs used for the various
Comfort Models (Entry, Pro, and Ultra). In Comfort, the NVM in U4
contains the programmed configuration, which is downloaded from
the PC using Comfigurator, or programmed using the keypad or
telephone using the Engineer Menu.

Comfigurator Download and Upload
In Comfigurator, select Options > Communications and select the
COM port (1 to 16), (or IP Address and Port in the case of
UCM/Ethernet)  to which the UCM is connected.
To transfer the programmed configuration to Comfort (“download”),
in Comfigurator, select Transfer > PC to Comfort. To transfer the
programmed configuration from Comfort to the PC, select Transfer
>  Comfort to PC.
During Upload and Download, both D11 (Green) and D12 (Red)
Leds will be blinking rapidly indicating data received and
transmitted to the RS232 port. D9 and D10 LEDs will also be
blinking fast simultaneously. Keypads and other modules will not be
able to communicate during this process.
Refer to the Comfigurator Reference Manual for details on using he
software. Refer to Programming with Comfigurator for Comfort  
programming concepts.

Master and Copy NVMs
IC sockets U2 and U3 are meant for the NVMs for the COPY,
COMPARE, TEST, UPLOAD and DOWNLOAD operations. The
designation of “Master” depends on the J4 jumper setting. If the
shunt in J4 is inserted in the position which is closer to U2, then U2
will be designated the Master and U3 the Copy. Similarly, if the
shunt in J4 is inserted in the position which is closer to U3, then U3
will be designated the Master and U2 the Copy.
The NVMs should be inserted in U2 and U3 with the UCM
disconnected from Comfort (i.e. with power removed).
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Copy “Master” to “COPY” 
1. With the UCM disconnected from Comfort (i.e. with power

removed), insert the NVMs into Master and Copy sockets U2
and U3. The NVMS should have identical memory capacities, or
the COPY NVM could have a greater capacity than the Master
NVM.

2. Insert the shunt in J4 so that it is closer to the “Master” NVM
and away from the “Copy” NVM.

3. Connect the 4 way cable between JP2/JP2A on the UCM and J15
on Comfort. The RDY LED should turn on and D9 and D10 leds
should start flashing.

4. Press the “COPY” button. The “RDY” LED should turn off, and
the BUSY1 led should turn on while the copy operation is in
progress. 

5. When the COPY operation is completed, the BUSY1 led turns off,
and the BUSY2 led turns on during the compare phase while the
MASTER and COPY NVMs are being compared.

6. When the Compare operation is completed, the RDY led turns
on and the BUSY leds turn off.

7. If an error is encountered during the COPY or COMPARE
operation the Error led turns on.

8. Remove power from the UCM by unplugging the 4-way cable
from either Comfort or the UCM. Before removing the NVMs.

Compare “Master”  with “COPY” 
1. With the UCM disconnected from Comfort (i.e. with power

removed), insert the NVMs into Master and Copy sockets U2
and U3. The NVMs should have identical capacities.

2. Insert the shunt in J4 so that it is closer to the “Master” NVM
and away from the “Copy” NVM.

3. Connect the 4 way cable between JP2/JP2A on the UCM and J15
on Comfort. The RDY LED should turn on and D9 and D10 leds
should start flashing.

4. Press the “COMPARE” button to  start the compare operation.
The RDY and ERROR leds turn off and the “BUSY 2” led turns
on.

5. If the compare is successful, the RDY led turns on and the
BUSY2 led turns off. If the two NVMs are not identical, the ERR
led turns on.

Upload Comfort NVM (U4) to “COPY”
1. With the UCM disconnected from Comfort (i.e. with power

removed), insert the NVM into either of sockets U2 and U3. The
NVM should have the same or greater capacity than the NVM in
U4 of Comfort.
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2. Insert the shunt in J4 so that it is away from the “Copy” NVM to
which the program in Comfort is to be uploaded. Note: In this
context “Upload” means to transfer from Comfort to UCM and
“Download” means to transfer from UCM to Comfort.

3. Connect the 4 way cable between JP2/JP2A on the UCM and J15
on Comfort. The RDY LED should turn on and D9 and D10 leds
should start flashing.

4. Press the UPLOAD button. All the data in Comfort’ s  U4 NVM
will be uploaded into the COPY NVM. The RDY led should go off
and the BUSY1 led should come on during the upload operation

5. The upload operation should take about 30 seconds for a
24LC32 (for FS17) and 60 seconds for a 24C64 (for FS31), and
up to 4 minutes for 24C256 (for FS34).

6. When the upload is completed, the RDY led should come on and
the BUSY1 led should go off.

Download “Master” NVM to Comfort NVM (U4)
1. With the UCM disconnected from Comfort (i.e. with power

removed), insert the Master NVM into either of sockets U2 and
U3. The NVM should have the same  capacity as the NVM in U4
of Comfort.

2. Insert the shunt in J4 so that it is towards the “Master” NVM
containing the program is to be downloaded to Comfort: In this
context “Upload” means to transfer from Comfort to UCM and
“Download” means to transfer from UCM to Comfort.

3. Connect the 4 way cable between JP2/JP2A on the UCM and J15
on Comfort. The RDY LED should turn on and D9 and D10 leds
should start flashing.

4. Press the DOWNLOAD button. All the data in the Master NVM
will be downloaded into Comfort’s NVM. The RDY led should go
off and the BUSY1 led should come on during the upload
operation.

5. The download operation should take about 30 seconds for a
24LC32 (for FS17) and 60 seconds for a 24C64 (for FS31), and
up to 4 minutes for 24C256 (for FS34).

6. When the download is completed, the RDY led should come on
and the BUSY1 led should go off.

7. The UCM resets Comfort automatically after a DOWNLOAD.

Test  NVM
1. With the UCM disconnected from Comfort (i.e. with power

removed), insert the NVM to be tested into the U2 or U3 socket
and insert the shunt in J4 AWAY from the NVM to be tested.
 Do this without power applied.

2. Connect the UCM to Comfort  and press the TEST button. Every
location will be written and read to ensure that the device is
working. After testing, the original data in the NVM is restored.
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The RDY led should go off and the BUSY1 led should come on
during the TEST operation

3. When the test operation is completed, the RDY led should come
on and the BUSY1 led should go off.
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CHAPTER 4  TROUBLESHOOTING

Common Problems

Serial Port
The most common problem with UCM communications is with the
serial port on the computer. Make sure that the UCM is connected to
the correct COM port, and that same port is specified in the Serial
Port setting for Comfigurator.
There may be compatibility problems with certain USB to Serial and
PC-Card to serial converters. These need to be tested with the UCM.

UCM ID
Check that there is no other UCM (UCM05, UCM/Audio,
UCM/Ethernet, UCM/CBUS, UCM/EIB, UCM/Smartfit) installed with
the same ID as any other UCM. This will cause a conflict of
addresses with more than 1 UCM responding to the poll from
Comfort.

SW8 Settings
SW8-F must be open for normal UCM, UCM05, UCM/Audio, and
closed for UCM/Ethernet.
SW8-G should normally be open.
SW8-H should be open for No Flow Control

LED Status Indications
The following describes what is regarded as normal LED indications
which will be seen on the UCM module when it is connected to  
Comfort.

D10 (green)
KA/KB or 12V/Ground not connected Cause

No Communications
D9 (Red)

zzzzzzzzzzzzzzzzzzzzzzzzzD10 (green)

UCM SW7 ID shunts may be set wrongly or
No of UCMs in Comfigurator may be wrong.

Cause
UCM is receiving data, but not responding. 

  z z z z z z z z z z z zD9 (Red)

zzzzzzzzzzzzzzzzzzzzzzzzzD10 (green)
Communications OK (Idle)
D9 (Red) and D10 (green) status indications for RS485
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D9 (Red)
D9 (Red) and D10 (green) status indications for RS485

The D10 (green) LED indicates RS485 data received from Comfort,
and D9 (Red) indicates data transmitted to Comfort.

zD12 (Red)
D11 (green)
UCM sends a report to RS232
D12 (Red)

zD11 (green)
UCM receives command from RS232 and does not Respond

 zD12 (Red)

z D11 (green)
UCM receives command from RS232 and Responds (e.g... login)

  z z z z z z z z z z z z zD12 (Red)

z z z z z z z z z z z z zD11 (green)
Uploading or Downloading from PC (Comfigurator)
D12 (Red) and D11 (green) status indications for RS232

The D11 (green) LED indicates RS232 data received from the PC
and D12 (Red) indicates RS232 data transmitted to  the PC.
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zD12 (Red)
D11 (green)
UCM sends a report to RS232
D12 (Red)

zD11 (green)
UCM receives command from RS232 and does not Respond

 zD12 (Red)

z D11 (green)
UCM receives command from RS232 and Responds (e.g... login)

  z z z z z z z z z z z z zD12 (Red)

z z z z z z z z z z z z zD11 (green)
Uploading or Downloading from PC (Comfigurator)
RDY, BUSY1, BUSY2, ERROR LED Indicators

Using Hyperterminal for Testing
This section shows how to communicate with the UCM using a PC
serial port. This is useful for those who are developing applications
for the UCM, or for those who have difficulty getting Comfigurator
to work with the UCM. Connect the UCM to Comfort and the PC
serial port as described earlier. On Windows 95/98/2000/Me, Run
Hyperterminal on the PC. This can be found at Start -> Programs  
-> Accessories -> Communications -> Hyperterminal Folder.
Double-click on the Hyperterminal.exe icon. A dialogue box for
“New Connection” will appear  as  shown below. Enter “UCM on
COM1 (or 2)” as the name and click on OK

The next screen is:
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On the box “Connect using, select “Direct to COM n” (where n is
your serial COM port to which you are connecting the UCM). Click
on OK

The next screen defines the properties of the COM port
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Set “Bits per second” to 9600, Data Bits” to 8, “Parity” to one, “Stop
Bits” to 1, “Flow Control” to Hardware and click on OK. This starts
the Communication screen

Universal Communications Module

19



On the Menu bar, select File -> Properties, and click on the
“Settings”  tab, and click on “ASCII Setup..”, and check the boxes
as shown below:

Click on OK, and OK again until you get back to the Hyperterminal
window. On the Menu bar, select View -> Font, and select Font =
Terminal, Font = Regular, size=9.
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Click on OK. You can now send characters to the UCM according to
the RS232 command protocol. Start with
<Control-C>LI1234<Enter> which is the login code assuming 1234
is a valid user code.  On Windows 95, you can see the text which
you type, but on Windows 98, you are not able to see your text
entry for some reason. <Control-C>, the Start character appears as
a heart symbol. You should get the reply LU01, which is Login User
1
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This shows that the communications with the UCM is working. Type
<Control-C>SR01<Enter> to enable status reporting from the UCM.
Now arm the Comfort system by pressing the AWAY button and
close the door. When Comfort arms the Hyperterminal window will
show;

The meaning of the messages is as follows:  IP0101 means Input 1
On (Open)
IP0100 means Input 1 Off (Closed)
MD015A means Security Mode 1 (Away Mode) by user 90 (5A in
hexadecimal notation). User 90 means one-touch armed by keypad
without any user code
AM095A means System Alarm 9 (System armed) by user 90. 
AL13 means Alarm Type 19 (13 is hexadecimal notation for 19
decimal)

When you are finished, save the session (File -> Save as ->
UCM.ht) so that you can recall the Hyperterminal settings without
having to go through the whole procedure again.
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CHAPTER 5   INFRARED LEARNING

Infrared Learning
The Comfort Infrared learning software is a Windows TM application
running on the UCM05 with IR receiver to learn new infrared signals
and save the codes in the .ifr file format which is used by
Comfigurator.
infrared.exe runs on an IBM PC-compatible computer running on  
Windows 98, Windows ME, Windows NT4, Windows 2000 or
Windows XP. It requires a UCM05 (Universal Communication
Module) RS232 interface connected to one of the computer's COM
ports to interface to the Comfort control panel.

Installation
The program is included with the Comfigurator software which is
supplied on a CD or downloaded from the Internet from the Cytech
Technology web site. (www.cytech-technology.com) or Comfort
distributors websites. Infrared.exe is also available as a standalone
program which can be downloaded from the Cytech web site. 
There is no installation required. The infrared.exe program must be
in the Comfigurator directory so that it can work with the ifr files.
To start the program, run infared.exe or start it from Comfigurator
in Tools > Infrared Utility

Definitions
Ifr file
A .ifr file contains the encoded infrared data for the commands for a
specific appliance. For example, a TV file may have On/OFF,
Channel 1, Channel 2, Mute, etc.. Each command in the ifr file can
be assigned as an IR Transmit code and downloaded to Comfort via
Comfigurator to be sent to any output using action 129.
The commands in an ifr file can be learned with the infrared learner
software.
The .ifr files are contained in the ifr subdirectory in the
Comfigurator directory.

Specification
Infrared Carrier Frequency: 35 kHz to 50 kHz
Learning distance: 5 to 10 cm.
Angle for reception: +/- 25 degrees
Encoding: ifr format
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Limitations and Disclaimer
Some infrared signals cannot be captured or encoded by the
software algorithm or used by Comfort because of limitations in the
encoding system.  The IR learner captures and encodes the IR
signals, while Comfort decodes the encoded signals to transmit from
any programmed output. The process of encoding and decoding will
introduce errors between the reconstructed signal and the original
signal. This works well in the majority of remote control signals
tested, but not for all possible remote controls.
Cytech Technology makes no claim about the efficacy of this device
or software to capture, encode or transmit any specific Infrared
signal.

Operation
Run the infrared learning program by double-clicking on
infrared.exe or from Comfigurator > Tools > Infrared Utility. 
The opening screen is shown below

To start learning IR signals for a new device which is not in the IR
code library (in the ifr subdirectory), press New... You will be asked
for the Brand, Device and Model number as in the screen below;
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Press OK to confirm. This defines the filename for the ifr file which
is to be generated.  You can now start to learn new functions using
the remote control.
To learn new IR codes for devices currently in the ifr directory click
on the arrow to the side of the window and select from the
drop-down list of appliances shown.

The above screen example for Mitsubishi VCR shows the learned
commands for this device in the bottom screen.

Rename
You can rename the function by selecting it with the cursor and
pressing the Rename button.
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Remove
You can delete  the function by selecting it and pressing the
Remove button.

Add
To learn a new infrared code, click on the ADD.. button

Enter the Function Name for the command, e.g.. Play, Stop, On, Off
etc.. The SERIAL PORT field will become visible. Change the COM
port number if necessary. Click on “Capture Signal” to start the
capture.  

Always use new batteries on the remote control, as
this gives the best chance of successfully capturing the
signal.
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When the screen above appears, point the remote control directly at
the IR receiver LEDs U8 and U9 about 5 to 10  cm away. Do not
place the remote control too close to the UCM board because  
the exact  location infrared transmitting LED of the remote
control behind the lens may not be known. Press and release
the button on the remote control which is to be learned. Do not
keep pressing the button unless it is required, e.g.. for dimming
lights. The BUSY1 Red LED will turn on when the UCM05 is waiting
for an infrared signal to learn. If a valid infrared signal is not
received within 20 seconds, the screen will time-out.
If the capture is complete, the BUSY2 Red LED will blink, followed
by the D12 Red LED (to indicate that the information was sent to
Comfigurator) and the following screen  will appear.
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This shows the waveform of the captured IR code. The numbers on
the horizontal scale show the time in milliseconds. 

Resolution
The Resolution window on the top right allows you to specify
different scales to observe the infrared signal.  The selection does
not change the signal in any way, just the magnification of the
signal on the screen.

Tolerance
The Tolerance window  allows you to specify the tolerance which the
encoding algorithm uses. The IR signal is encoded in the Comfort ifr
format, so that the space required in Comfort’s memory is
minimized. In encoding the signal using the IR learner and decoding

Universal Communications Module

28



the encoded code in Comfort, there will be differences between the
original IR signal and the reconstructed signal transmitted from
Comfort. These differences are in the length of the pulses and the
gaps in the captured waveforms as well as the carrier frequency.
Specifying a larger tolerance may allow the algorithm to encode the
signal more efficiently, resulting in fewer bytes required for the
signal. Comfort imposes a limit on the size of the encoded IR signal
due to memory limitations. For Outside firmware the limit is 96
bytes while for Entry firmware, the limit is 50 bytes. Although the
IR Learner software is able to capture and encode signals which are
greater than 96 bytes, Comfort will not be able to decode and
transmit these signals.  Specifying a larger tolerance may result in a
code which is less than the limit allowed.  However, applying too
large a tolerance could result in incorrect encoding of the signal.

Encode
Press the ENCODE button to initiate the encoding process. The
screen below shows a typical result;

The number of encoded bytes is shown at the end of the data in the
above window. To save the code into the .ifr file,  click on the YES
button.  The encoded data is saved as an ifr file. The filename is
automatically generated from the equipment type, manufacturer,
and model number which was entered earlier.
Clicking on the NO button will return to the previous screen where a
different tolerance can be specified.

Crop
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The Crop button on the waveform display screen allows you to
delete the last part of the signal in order to achieve a code size
within the limit. Some IR codes have single or repeated pulses at
the end of the signal which may not be needed to achieve the
function. The presence of these pulses defeats the algorithm which
looks for repetitions of patterns in the signal. If a pattern is
repeated in the signal, but followed by some pulses which are part
of the pattern, then the entire signal cannot be coded as a
repetition. To crop a signal,  click on the point in the signal after
which the signal is to be cropped. The remaining part of the signal
before the cursor will be acted upon by the encoding algorithm.

Save To File
This button saves the waveform in .raw format. This file can then be
sent to Cytech Technology (email:
techsupport@cytech-technology.com with full details) for analysis  
in case of problems with encoding.  This does not save the
encoded file in the .ifr format

Infrared Learning Errors 

“Infrared Signal is too long”
If this message appears before the remote control button is
pressed during learning, it means that random IR signals are being
received. This could be due to certain types of fluorescent lights. Try
again with the lights  off or in another room.
If the error message is seen after the infrared signal is sent, it
means that the signal being learned is too long for the system to
encode, probably because it has an unusual format. The UCM05 is
not able to encode all types of  remote controls

“Erroneous signal or Out of Frequency Range Detected”
This message may received if the remote control is not pointed
directly at the receivers or is too far away. The  remote control
should be pointed directly at the infrared receivers U8 and U9 at a
distance of 5 to 10 cm away.
Some remote controls operate outside the frequency range of 35 to
50 kHz in which the receiver can detect. Such infrared signals
cannot be learned by the UCM05.

“Infrared Signal is Too Long”
This may be cause by pressing and holding the remote control
button. Try again after clicking the “Capture” button, by pressing
and releasing the button.
However a small percentage of infrared signals are really too long to
be learned by the UCM05.

“Error Encountered during Encoding - Exceeded Bytes”

Universal Communications Module

30



This message is received when the infrared signal is not one of the
known formats which requires too many bytes to encode. Such
infrared signals cannot be learned by the UCM

Problems with Learned IR Codes 
Sometimes, the infrared signals can be captured and encoded
successful, but when transmitted through an Infrared LED
connected to an output, it does not activate the device. The possible
causes and solutions are

Encoding Errors
The UCM05 may encode the signal incorrectly if the remote control
is not pointed correctly at the receivers.  The  remote control should
be pointed directly at the infrared receivers U8 and U9 at a distance
of 5 to 10 cm away. The remote control should not be too close to
the receivers because the actual location of the transmitter LED
behind the infrared lens is not known. The transmitter may not be
at the center of the lens so it may be pointing at the wrong angle.
Positioning the remote control 5 to 10 cm away will reduce the
effect of the uncertainty of the location of the transmitter.

Programming Errors
The infrared code is sent to any output using Action 129 (or using
the Response Wizard in Comfigurator). Check that the correct
infrared code number is sent to the designated output. A useful
diagnostic tool is to plug in a Test Lamp terminal Block into the
output header. 

This consists of two 12V DC lamps which light up when the output is
turned on. When an infrared signal is sent to the output, the lamp  
will briefly blink. It should not be permanently turned on. This
shows that the output is receiving an infrared signal, but it does not
mean that the IR signal is the correct one. A useful tool in any
installation where infrared transmission is needed is a long length of
wire, about 30 meters with an IRM01 transmitter on one end and a
terminal block on the other. This can be quickly connected to any
output and the transmitter pointed at the appliance to operate it.
This will show if the programming is correct.
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Wiring Errors
The most common cause of infrared signals not working is wiring
errors. The infrared IRM01 transmitter may not be connected to the
designated output, or the polarity of the IRM01 may be reversed.
Use the long length of wire with IRM01 at one end and a terminal
block at the other to determine if the programming is correct or the
wiring is correct.
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CHAPTER 6   UCM/ETHERNET

Figure 5.1 Photograph of UCM/Ethernet (Flash)

The UCM/Ethernet module allows the Comfort system to be
connected to a Local Area Network. This module converts the serial
data of the UCM to the industry-standard TCP/IP protocol over the
Ethernet. This allows the Comfigurator software to upload and
download Comfort configuration and allows WizComfort which is a
stand-alone user software to access Comfort, over the LAN instead
of using a serial port on the PC. One advantage of network access is
the RS232 cable is limited to about 5 to 10 meters from the PC thus
requiring the UCM to be located close to the PC. The UCM/Ethernet
can be located in or next to the Comfort panel, and far from the PCs
on the network (up to 100 meters away). 
The serial protocol of the UCM can be used by third party
developers to develop customized applications for Comfort over the
network or Internet.
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Connection to UCM baseboard

Figure 5.2 View of Ethernet Daughterboard

The UCM/Ethernet consists of a daughter board (ETH01) shown in
the diagram attached to a UCM05 Baseboard via a 10 way
connector.  A UCM05 can be  converted to a UCM/Ethernet by
adding the ETH01 daughterboard, and setting the shunt J2 to the
“RS485” position.

Specifications
Ethernet Interface: 10BaseT 10 Mbits per second
Network Protocols: TCP, UDP, ICMP (ping), ARP
Serial Interface baud rate: 9600 bits per second
Current Consumption: 65 ma (typical), 100 ma max from Comfort
12V auxiliary output. 

Connectors
MJ101 - RJ45 connector for Ethernet Local Area Network. 

Shunt Settings on UCM05
J2 (RS232/RS485) should be in the “485” position
SW8-F (Ethernet) should be inserted
SW8-G (Action 197 STX/ETX) should be left open for use with
Comfigurator and WizComfort
SW8-H (RTS/CTS Flow control) can be open (No RTS/CTS Flow
Control) or inserted (Flow control). This must correspond with the
software setting with Device Server Manager. It is recommended
that Flow control be enabled.

SW101
Pushbutton switch for Setup - Not in use.
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Ethernet LED Indicators
D101 - Collision (Red) - This blinks when there is a data collision on
the Ethernet Network
D102 - Data Received (Green) - This is normally on and is blinks off
when Ethernet data packets are received.
D103 - Status (Green) and D104 - Status (red) provide status of
operating modes and error conditions, as shown in the table.

D103
z z z    z z z D104

TCP connection has been reset (rejected) by remote host
D103
D104
Connection established, no data transfer, data overrun
D103
D104
Connection established. data transfer, no overrun
D103
D104
Connection established, no data, no overrun

z z z       z z zD103
D104
Connection is being established

z z z z z z z z zD103
D104

Device Server sending ARP  to get MAC address of
destination

z z    z z   D103
D104
Connection is Closed

z     z     zD103
D104
DHCP Enabled but IP address not obtained yet
D103
D104
Ethernet Port Failure
D103

z z z z z z z z z z z D104
Error Mode

 z z z z z z z z z z z D103
z z z z z z z z z z z D104

Serial Programming Mode (Not in Use)
D103 (Green) and D104 (Red) Status Indications

Universal Communications Module

35



Comfort System Requirements
Comfort firmware: Outside 4.166 (older versions can be used for
upload/download via Comfigurator). Comfort Entry can be used for
upload/download only.
UCM Firmware: UCM 5.62 and above
Comfigurator: 1.1.6 (implementing support for Network
Connection.)

Getting Started
This assumes that the person doing the configuration and Setup is a
technical specialist with a knowledge of Ethernet and TCP/IP
networking.

Set UCM ID and Number of UCMs
Set the UCM ID on SW7 according to Table 1.1.  By default, the ID
is set to 1.  If the ID is not 1, set the number of UCMs in
Comfigurator accordingly, and download the setting to Comfort.

Connect UCM/Ethernet to Network and Comfort
Connect the Ethernet port MJ101 to the Local Area Network (LAN)
by means of a hub or switch using a parallel CAT 5 cable.
Plug in the 4-way cable from JP2/JP2A on the UCM to J15 on
Comfort, and press the RESET button on the UCM. It is assumed
that Comfort is already running. The RDY LED on the UCM should
turn on steady and the LEDs D10 and D9 should be flashing
continuously. On the Ethernet module, D103 (G) and D104 (R)
should flash 3 times initially. After that, D103 (G) will blink twice
every few seconds and D102 (G) should be on.

Device Server Software
To set up the IP address and the other network and serial port
settings, install the Device Server Manager Software. This is
available from our website as a zipped archive. 
http://www.cytech-technology.com/software.html.  Unzip the file
and install the software. The Device Server Manager opening screen
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is shown below;

The  IP address of the UCM/Ethernet is found by the auto-discovery
process, 127.0.0.1 by default. The IP address must be changed to
one which resides on the same subnet as the computers which will
be accessing the UCM/Ethernet through the network. For example,
if one of the computers on the network has an address like 10.0.0.1
and the subnet mask 255.255.255.0, the IP address of the
UCM/Ethernet can be set to any address in the range 10.0.0.2 to
10.0.0.254, making sure that it does not conflict with any assigned
IP address on the network. Click on the “Change IP” button. Enter
the new IP address of the UCM/Ethernet. This is not necessary of
the DHCP feature is enabled in the Network Settings page.
On the DS Manager screen, the new IP address should be shown.
The UPGRADE button is used to upgrade the firmware on the
Ethernet board (NOT the UCM firmware U1) over the network.
Firmware upgrades will be available from the Cytech Technology
Website. To upgrade, press the Upgrade button and select the name
of the firmware file. The current firmware is CYTEM312.BIN.
Upgrading takes only a few seconds.
The INITIALIZE button initialized all settings back to factory default,
except for the IP address.
The ROUTING STATUS button shows the status of Routing buffers,
Network Connection and Serial Port, as shown in the screenshot
below.
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The BUZZ button causes the RED and GREEN Status LEDs to blink
for a few seconds so that the UCM/Ethernet module which is being
accessed can be identified. This is useful if you have several
UCM/Ethernet modules connected (Comfort can be connected to 8
UCMs of various types)
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UCM/Ethernet Settings
Select the IP address using the cursor and click on the  Settings
button. The Settings screen is shown below;

Owner Name and Device Name are for description only.
MAC Address is the physical Ethernet Address of the device. It
should not be changed
DHCP  If enabled, it allows the device to be automatically assigned
an IP address if there is a DHCP sever in the network.
IP Address is the current IP address of the device.
Port is the network port through which the data is sent and received
from the UCM. By default, the port is set to 1001. 
Transport Protocol:  You can choose TCP or UDP. For Comfigurator,
TCP should be selected.
Connection Time-out: This is the time in minutes (0 to 255) for
which the TCP connection will remain open if there is no data in
either direction. A value of 0 means the connection will never
time-out.
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RTS/CTS Flow Control: 0 disables Flow control while 1 enables it.
This must correspond with the shunt setting on the UCM SW8-H. It
is recommended that RTS/CTS Flow control should be enabled to
avoid loss of data.

The button SAVE at the bottom saves the profile under a file name
that you specify with the extension .ds. The button LOAD allows you
to load a previously saved profile.

The PASSWORD button is not used. Ignore it.

The TAB called ALL displays the same settings as the Settings
screen. The use of this screen is thus not needed, but it may be
used for future expansion of settings.

Comfigurator Network Connection
To use Comfigurator to connect to Comfort over the network instead
of the serial port, select Menu Options > Connection..

In Connect Using, select Network. In Port Details, enter the IP
Address and the Port number which was set for the UCM/Ethernet
and click OK.
Upload and download (especially Upload) over the network will be
slower than for direct serial connection because of the additional
communications overhead incurred on the Ethernet.
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CHAPTER 7   UCM/AUDIO

The function of the UCM/Audio module is to allow voice to be played
on an external powered speaker or PC and to allow intercom and
recording functions from a PC running software like WizComfort. It
also allows a virtual keypad simulation with WizComfort.
The Audio function is a daughter board which fits on a standard
UCM01 connected by a 10 pin connector and is secured by 3 screws.
The UCM/Audio will also function as a normal UCM for
upload/download with Comfigurator, and Copy/Upload/Download
functions involving the Nonvolatile memories (NVM) and Infrared
learner if the base board is a UCM05.
The firmware is the same as a regular UCM05.

Figure 7.1 - Photo of UCM/Audio (Flash)
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Figure 7.2 Audio Module and Connections

Connections
JP101  (VOICE/MIC): Connected to VOICE and MIC from
Comfort Main Board. 
JP102 (OUT/IN): OUT is to be connected to the PC LINE IN or to
a Speaker with built-in amplifier. This is the same signal as in
PJ102. IN is to be connected from the Line OUT jack of a PC.
PJ101 Audio socket: This is for connection to a dynamic
microphone of the type used in PCs. Use a 3.5 mm mono audio
jack. This path has a higher amplification than the JP102 IN
connector. LINE OUT from a PC can be connected to this jack,
but VR102 must be tuned to reduce the gain.
PJ102 Audio socket: This is to be connected to the PC LINE IN
or to a Speaker with built-in amplifier. Use a 3.5 mm mono
audio jack. This is the same signal as in JP102 OUT.

Adjustments
VR101 (VOICE): This adjusts the volume of the Voice signal to
the speaker or PC LINE IN
VR102 (MIC): This adjusts the gain of the Microphone Input
signal  from PJ101 or the PC LINE IN signal from JP102
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Operation with WizComfort
This section shows how to set up and use WizComfort to test the
audio functions on the UCM/Audio.  
Connect a dynamic microphone to PJ101 and a computer-type
speaker to PJ102 as shown in figure 6.2
Connect MIC and VOICE from JP101 to Comfort terminal block JP15
(MIC and VOICE). This is for the audio signals.
Connect the serial RS232 cable between the PC Serial Port and the
RS232 connector P1 on the UCM.
Run WizComfort (free download from 
http://www.cytech-technology.com/software.html.)  The version
used should be 1.30 and above. Run the program and click on
Setup > Options.. 

In Connection Setup, select Serial to UCM, and select the serial port
used to connect to the UCM.
In the Files tab shown below, select the Comfigurator filename used
to program the Comfort system, the location of the IFR infrared
files, and the location of the iomap.cym. The usual locations are
given in the figure below.
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Click OK to return to the main WizComfort page.
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Enter your user code (default 1234) in the PIN box, and click on
Login. If the code is correct, the status box will turn green and will
show that you are  logged in. To use the virtual keypad, press the
digits for user code to enter the user menu, or press F 2 for Home
Control menu or any other function that you can use with a real
keypad. The voice menu will be heard on the speaker. Adjust the
VR101 trimmer to change the volume. The volume of the voice will
vary depending on the speaker used. There will usually be a volume
control on the speaker as well.
Press F8 to enter Intercom Mode, and talk into the microphone
connected to PJ101. This will be heard on all other keypads in the
usual way.
You can also press F4 to record a message. Talk into the
microphone to record your message.
This illustrates how the audio function works on the UCM/Audio.
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CHAPTER 8   FIRMWARE UPGRADING

The Flash-based UCM allows its firmware to be upgraded using
Comfigurator 2.2.2 and above. The UCM05 is the means by which
firmware upgrading of other flash-based Comfort modules is
accomplished. In order to upgrade the firmware of the UCM05,
another UCM05 is needed. The UCM05 cannot upgrade its
own firmware. The minimum UCM05 firmware version which
supports firmware download is UCM 5.147 but it is
recommended that UCM firmware 5.156 and above is used, as this
allows firmware download without requiring a login (see below). The
UCM Programming cable shown below is supplied with the UCM05 

To be connected to
PP1 and PP3 of the
UCM to be used for
programming

To be connected to PP1
of the module to be
programmed

Figure 8.1 - UCM Programming Cable

1. The end of the programming cable with two connectors is to be
connected to the UCM05  or UCM/Ethernet to be used for
programming, and the end with a single 6 way connector is
connected to the module (Flash version whose ffirmware is to
be upgraded.

2. For the module to be upgraded, shunt PP2 and connect the
programming cable (with 6 cables end) to PP1.

3. Connect the other ends of the cable to the UCM05 that is used
for programming to PP1 (4 way) and PP3 (2 way).

4. For the module to be programmed, ignore the RS485 ID
settings, and disconnect the module from the Comfort Rs485
Bus

5. For UCM05 firmware < UCM5.156:  If the Module to be
programmed is a Flash-based Comfort  MPU01, do not connect
the MPU01 to the Comfort PCB. For UCM5.156 and above, the
MPU01 can be connectyed to Comfort during the firmware
download

6. Power up Comfort.
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7. For UCM < 5.156, Login on the UCM by doing a Transfer >
System Information. For UCM 5.156, this is not necessary

8. While the UCM05 is connected to the module to be
programmed, and the firmware download is proceeding, the
Comfort RS485 Bus will not be able to communicate with
Comfort and other modules, so there will be Communications
Failure  with resulting beeps on keypads. Turn down the volume
on keypads if necessary

Downloading the Firmware
1. Run the Comfigurator software 2.2.2 or above. Ensure that the

right connection setting is set. Go to the Transfer Menu and
select “Firmware Download”.

2. Note: Comfigurator 2.2.0 to 2.2.1 will prompt for Engineer
Code. Press F0 on the keypad  enter the Engineer Code (default
6789). Click on “OK” after that. Skip this step for Comfigurator
2,2,2 and above

3. Next, Comfigurator will prompt for the file to be downloaded.
Navigate to the correct firmware file to be downloaded and
select it and click “Open”.

4. After doing so, Comfigurator will give a warning prompt,
informing users that the firmware version will be downloaded. If
the firmware file selected belongs to a different type of module,
the download will be rejected,  Click on “OK” to proceed with
the firmware download.

5. If the firmware download operation fails  for any reason,
do not reset the UCM.  Check your connections and
settings and repeat the process. Resetting the UCM
before the completion of the firmware download may
cause the flash to be erased, and the identification to be
lost. The UCM05 would have to be returned to the factory
to be reprogrammed.

6. After the download has completed, disconnect the UCMs from
the system. Disconnect the UCM Programming Cable and
remove the shunt PP2 on the newly programmed module.

Version History
UCM 5.156 (19 September)
1. Firmware download does not require prior login by UCM

UCM 5.155 (2 August 2007)
1. TC command to copy all characters in Rs232 to Rs485. 
2. Prevent invalid RS485 messages from beng sent by firmware

when RS485 buffer overflow or message not initialised or closed
3. Increased RS485 receive buffer size to 96, transmit buffer  to

240

Universal Communications Module

47



4. Increased size of buffer for learned IR codes
5. Fixed BUG from 5.120 EEPROM write to U2 as COPY does not

work,
6. Improved MO01 monitor mode so there is no corruption of data

UCM 5.147 (15 April 2007)
1. Firmware Download is supported

UCM 5.92 (5 Oct 2005)
1. Implemented KL message for keypad LEDS status
2. Implemented K? Command to request for keypad Led status
3. Implemented v?, v! Commands for vocabulary (Comfort II)
4. Implemented VS commands for download of Comfort II vocab
5. Implemented Download of KP data from Comfigurator 2.0 and

download of KP text to new KP04
6. Can be used to download 32 bytes per line for Comfort II
7. Implemented SM commands (used for Companion)

UCM 5.79 (7March 2005)
1. SW8-E and SW8-G shunted at RESET disables RS485/232

communications for testing purposes 
2. Defined ER command for arm ready/not ready status. ERzz to

RS232
3. UCM firmware and Processor upgraded to allow more memeory

for learning of IR codes. UCX firmware does not include IR
Learning

UCM 5.76 (14 Oct 2004)
1. Implemented TM command
2. Implemented B? Query, BY report - requires firmware

Outside/Action 4.230
3. I! Virtual input allowed for inputs 1 to 16
4. SW8 - G shunted causes RS485 and Rs232 to be disabled
5. IL command for IR code downloading implemented, not tested.

Requires Outside/Action 4.228
6. KP04 Language Download function implemented

M 5.70 (19 May 2004)
1. Implemented R! Which accepts 2 bytes for Ultra 2-byte

response command. Requires Action 4.216 and above for
compatibility.

UCM 5.63 (25 September 2003)
1. PS01/PS00 is reported when there is engineer sign in and sign

out. The report does not require login LIXXXX.
2. UCM identifies its own type to Comfort at startup.
3. Improvement in the  handling of messages on serial port

prevents corruption of a transmitted message by an invalid
received message
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4. Fixed bug where if a command without the header (STX) is
received, the previous reply is resent. Now, when there is no
header, no reply is sent.

5. SW8-F setting for UCM/Ethernet must be shorted. For normal
UCM01, open SW8-F (but shorting will have no effect)

6. Changes to RTS/CTS flow control operation. CTS was set during
transmission of data to RS232 port to prevent any received
characters, but this limitation has now been removed.

UCM 5.45 (16 November 2002)
1. SW8-G shorted selects Action 197 with no leading STX and

training CR. When Action 197 sends text to the RS232 port
without STX and CR, it disables UCM Status reports to RS232. A
Login will restore status reports again and allow downloads to
take place.

2. Support for IR Learning

UCM 5.33 (17 June 2002)
1. supports Voice Download VL, VP commands
2. Prevent potential problem where during download, PC delay

causes data to be downloaded from COPY EEPROM

UCM 5.27/5.28/5.29 (9 April 2002)
1. Supports new rev D1 UCM with selectable Master/Copy, can also

be used with rev C UCM.

UCM 5.23 (26 March 2002)
1. UCM/CF Type 10 with Comfigurator license

UCM 5.15 (17 Jan 2002)
1. New commands  Z?, Y?, z?, y? to query for no of zones, outputs

RIO (remote Input/output) inputs and outputs. Requires Outside
4.48+ for these commands to work.

2. UCM will reply “OK”  for commands RM, C!, I!, X!
3. Added command a?  for alarm type.
4. If the COPY button is pressed and Copy or Master EEPROM not

inserted, the  ERROR LED turns on.
5. If Master capacity is  greater than Copy, Error LED turns on.

Previous behavior is copy only up to the COPY EEPROM
capacity.

6. Supports up to 256KBits for MASTER and COPY sockets.

UCM 5.11 (4 August 2001)
1. Added KD command to enter keypad digit for keypad simulation
2. Added SP command for keypad to ignore broadcasts similar to

action 139
3. Action 197 sends text to RS232
4. Fixed bug where C? replies even when not logged in

UCM 5.05 (29 May 2001)
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1. Fixed bug where if the received checksum from Comfort RS485
is wrong, UCM did not ask for retransmit

2. C! Command now allows more than 1 set of counters to be set
3. Implemented S? Command

UCM 5.02 (2 April 2001)
1. Comfort Version information is obtained using V? 
2. UCM Version information is obtained using the U? Command.
3. During upload and download, the UCM will automatically disable

status reporting (like SR00) until another LI valid login is
received. This prevents status reports from disrupting uploads
and downloads. At reset, status reports are disabled until LI  is
received When a login is received, status reporting is enabled,
similar to SR01. When there is a logout, Status reporting is not
disabled, as it may still be needed

4. Implemented DB report for doorbell press

Manual Revision History
3.3.3 (23 Setpember 2007)
Added instructions for UCM 5.156 and warning about resetting UCM

3.3.2 (13 September 2007)
Added instructions on J2 header rework for older UCM05s

3.3.1 (20 August 2007)
Revised Chapter 8 details on Firmware download

3.3.0  (12 July 2007)
Applies to Flash-based UCM. Added Chapter 8 on Firmware
download

3.2.1  (16 May 2006) 
Removed UCM01, added version 5.92. Added Manual Revision
History

3.2.0 (10 December 2005)
Troubleshooting “ IR codes too long”

3.1.9  (18 June 2005)
Version history updated to 5.79. Added shints SW8- G and E shunt
at reset cause no comms for testing (Daikin)
Changed references Ace Comfort to WizComfort

3.1.8  (18 July 2004)
Removed UCM/GSM - descrbed in UCM/GSM manual
Added UCM 5.70 and 5.63 to version history

3.1.7  (3 July 2004)
Added 3.5 mm audio jack size of audio
Added size of module

3.1.6 (March 2004)
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Added Troubleshooting - Common Problems
Adding UCM/GSM

3.1.5 (20 Sept 2003 )
Added UCM/Audio, UCM/Ethernet
Added leds D9, D10, D11, D12 tables

3.1.4 (1 Sept 2003)
Corrected mistake on RS485 primary/aux labelling

3.1.3  (2 May 2003 )
PCB Rev E, new locations of Ics and IR LEDs

3.1.2  (6 March 2003)
Ucmirman combined with ucmman. Removed ucmirman.

3.1.1  (24 Feb 2003)
TEST COPY NVM changed to “TEST NVM” with shunt AWAY from  IC
to be tested, not towardss

3.1.0 (Nov 2002)
Added IR Learning

3.0.3 (27 Sep 2002 )
1. Added SW8-G for suppression of STX and CR

Dec 2001
1. UCM ID 1 reserved for UPload/download

Sept 2001
1. Spelling and other corrections
2. SW7, 8, changed pins to A toH 
3. SW7 caution not to insert shunts in D to H

June 2001
1. Corrected ID settings error for SW7
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